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What’s New

The following enhancement is included in this release. If you have any questions regarding this release,
please contact e-Builder Technical Support.

Submittals

Submittal Coordinator Reassignment

In projects with multiple submittal coordinators, the construction team may send their submittal items
to the incorrect submittal coordinator by mistake. Previously, the submittal coordinator could never be
changed from the original selection to fix such errors or in cases where a submittal coordinator left the
project.

With this release, project submittal coordinators and administrators can edit the item and change the
submittal coordinator while a submittal item is in review.

A safety check has been added to the Submittal Settings to prevent users (coordinators) from being
removed from the submittal coordinator list if they have items assigned to them. The items need to be
re-assigned before the coordinator(s) can be removed from the list.

Ensure that the Allow Submittal Coordinator and Administrators to edit submittal item fields while in
review setting on the Submittal Settings page (Setup> Admin Tools> Submittals> Submittal Options>
Settings) is enabled.

Note that this setting allows several fields to be edited if selected by the Admin.

Plann@] Documents Calendar Time Tracking

Submittal Settings

Save Cancel

System Generated Dates (7] Allow system generated Submittal Dates To be modified

In Review Allow comments and attachments to be hidden

Restrict view of Hidden comments to only submittal coordinators and reviewers of submittal items

Changes Private comments to Public (visible) when shown in review

Allow Submittal Coordinator and Project Admin to edit submittal item fields while in review

Manage Fields for Submittal Items

Field Name Description Edllt n ew | Required
*Project The project name ¥
*Title The title of the submittal item 4

Submittal numhers are nenerated by a-Buildear in increments

Allow submittal item fields to be edited while in review
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Submittal register items may be assigned to different submittal coordinators.

Submittal Register for [susans Classy Clubhouse v
Filter Submittal Items

Update Status Forward for Review Send to Sub Add to Package Add Item Delete

Group By | None v Page |1 ¥ | of 1 Show |25 ¥ | perpage \ =
ul

Item Details | Title #a4 |Rev# |Package# Spec Section Sub Section Category Status Subm|.tla| Held By Reviewers
Coordinator

0= REVISE Susan
create by 1 4] 1-01200-0 Bid Submittals Approved a: * | COORD Susan Parker  Reviewers
GC *Parker

0 — REVISE - Operation /
by GCas 2 1] 2-01300-0 Maintenance Approved a: * | Susan Parker | Susan Parker  Reviewers
SC Manual

Multiple submittal coordinators for different submittal register items

For items in review, project submittal coordinators and administrators can edit the register items and
change the Submittal Coordinator to another coordinator assigned on the project.

When an item is reassigned to a different coordinator, the new person will receive email notifications
about the submittal item assignment. The History tab of the submittal item will also have an entry about
the coordinator change.

Edit Submittal Item

Details Save | Cancel
Project Susan’s Classy Clubhouse
* Title REVISE create by GC Status AAN - Approved as Noted
Number 1 Itern Status Open
Description Submittal Coordinator Susan COORD *Parker ¥
Package 1-01200-0 Priority
Spec Section - Revision
* Category Bid Submittals v Sub Section
Responsible Sub/Manufacturer Commitment

Changing the Submittal Coordinator while an item is in review

Note: The Submittal Coordinator list must have at least one name assigned. If multiple submittal
coordinators exist, they cannot be removed from the list unless they are under the “No items in review”
heading.
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Submittal Settings for PS Submittals - Susan's Sandwich Shoppe

Project:

Complete Review Date Due Offset:

Offset Type:

Specify Default Folder For Attachments:

% Submittal Coordinator:

PS Submittals - Susan's Sandwich Shoppe
10
Calendar Days
® working Days
Documents \ Submittal Documentation

Select From: | All Roles b

Ashley Paddock -
Susan GC Parker
Susan PM Parker

[Change Folder]

1

lemove Folder]

Items in review

No items in review
Susan DESIGN Parker

Only submittal coordinators in the “No items in review” list can be removed from the submittal

coordinator list
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Search

For attachments that are stored inside a Form instance and not inside the project Documents module,

the Global Search results were not displaying accurate results. These attachments will now be listed

under the Documents results section with a link to the Form instance under the Location column.

[l Search Options @)

Limit Search To

Search In

Expand All | Cellapse All

# Documents (2)

Project &

Susan's Mountain Retreat Cetaa\ Documents

folders

Select All | Deselect All

¥ Bidding Information
Sslzndar Events

madioa

Location =

99 File Sharing (PUBLIC)

File Name =

2018 Tips & Tricks Admin

condensad.pptx

Attachments stored inside a Form instance will be listed under the Location column

Description %

10
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Resolved Cases

The following is a list of resolved cases for the past month. If you have any questions regarding this
maintenance release, please contact e-Builder Technical Support.

API
Case # Resolution Notes
347277 Fixed the API to ensure it can return all dates including null last modified if a
datemodified parameter is not specified (and to not default to min date).
AppXchange
Case # Resolution Notes
339977 Resolved timeout exceptions that occurred during the invoices import process.
345704 Added support to handle custom field values for Project Imports. Also, resolved
validation issues for SQL query generation around null data values.
348710 Optimized the stored process by adding account filters and made additional minor
changes.
348710 Resolved an integration timeout issue.
353671 Fixed an issue where a project could not be imported successfully.
Calendar
Case # Resolution Notes
348778 The content in the Meeting Minutes Description column was not wrapping as
expected. The problem was related to the table styles and rendering of the Discussion
content on that table. This has now been resolved.
350236 Corrected an error with meeting invitations sent incorrectly to certain users who had

Eastern Time selected in their user profile.
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351194 Resolved automatic spell check errors caused while trying to save a calendar event.
Cost

Case # Resolution Notes

328631 Optimized the code that voids a master invoice to use a single SQL connection /
transaction to process all commitment invoices. The system will update the cost
summary dynamic columns and funding once after all commitment invoices have
been processed.

329589 Added code to resolve the issue when ReasonCodeDesc and Reason Code are used in
same Subject formula for the process.

331385 For negative budget lines, the Cash Flow was not rounding out extra cents correctly.
Now, if there is a remaining amount to be allocated, it is adjusted in a month in order
to be able to save the recalculation.

344001 Users can now delete the cost data without errors. Code was added to remove the
commitment funding source while deleting all cost data.

344064 Resolved an issue where the 'Cost To Complete' column was not displaying the
correct calculation if there was a dynamic column included in "Net Actuals Paid".

344676 Resolved an issue where no pending items were displayed in the 'ltems Pending
Approval' section of the Home page even after they received a notification.

346057 Corrected the code to prevent failure and issues while adding master commitment
items.

346278 Updated the export to include cost control violations in the export file.

346656 Selecting the 'Hide zero value lines' check box for months that had values incorrectly

affected the monthly spend. This issue has been resolved.
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Custom Development

Case # Resolution Notes

339963 Scheduled tasks were failing with the Missing or invalid property error. When all rows
had an exception, this error was happening. This was fixed so that the exception file is
also created in this scenario.

345824 The process did not go to the next step and an error was generated. The recent
upgrade to Aspose Cells uncovered badly formatted formula.

346912 The query to update the cost summary was being done inside a transaction, which
was blocking it and causing the timeout exception. The location of the query was
changed.

348163 When running a custom scheduled tax, long numeric values were converted to
exponents. This issue has been resolved.

348535 A custom report could not be opened in MS Excel because the file extension did not
match the format of the file. The report produced was being saved with the .xIsm
extension, but the file format was .xlsx

Dashboards

Case # Resolution Notes

339109 Resolved an issue where data was displayed incorrectly on a dashboard if the '% of
the total' aggregate function was chosen as the data to display.

344567 Resolved an issue where a report was not properly displaying the results in the
dashboard.

347686 The Refresh button is now visible for all Standard Dashboards.

349071 Inconsistencies were found in Dashboard Line Graphs and the values pulled from

Reports. The custom format being used for the Y-Axis was not working properly for
Line Charts. The format was not including decimals, causing the values to be rounded.
This has now been resolved and the system supports decimal values and displays the
expected values.
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Documents

Case #

Resolution Notes

333736

334651

343696

345232

346193

350799

In the Documents/Sent Items section, messages that failed to be sent out of the e-
Builder system were not recorded with a failed status (such as attachment file not
found). Failures will now be recorded immediately in the message, and the system
will try to re-send it 5 times.

The status will be changed to Successful if any of the re-tries work. Note that
"success" means the message left the e-Builder environment but does not indicate
that it was received successfully. Messages can still fail from a customer perspective
due to invalid email addresses, full inboxes, etc.

Files with O-byte file size cannot be uploaded through WebDAV.

Finalized Bluebeam session did not release license, and sessions were not finalizing on
time. Added additional logging to track the behavior of the scheduled task when
finalizing the session and analyze it in case of future issues.

In the Stamp tool, users were unable to create stamps using the Tahoma font along
with the italic font style. The system will now use the Tahoma regular font as a
fallback option in case it cannot use the italic font style.

An incorrect error message appeared when uploading a file that was checked out by
another user. The error message was corrected to reflect the actual behavior.

When using IE, users will now be able to vertically scroll through their visible files on
the Project Documents page. Resolved an issue preventing the vertical scroll bar from
being displayed on the page.

Event Handler Engine

Case #

Resolution Notes

350901

For users with Create permissions on a Documents folder, the Custom Fields data
entry screen should always appear when uploading files to that folder.
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Forms

Case # Resolution Notes

346557 If form types were filtered by values within a global project custom field and the
custom field values were modified, the filter was getting lost. This has been resolved
to retain the filter and values that still exist within the global custom field. Values that
do not exist are removed from the filter.

Home
Case # Resolution Notes
350894 Fixed an issue where Quick Start was not displaying the most used processes or forms

Login Issues

for the user.

Case # Resolution Notes
352606 Resolved a required field conflict that prevented a user from logging into the mobile
application.
Mobile App
Case # Resolution Notes
337628 Resolved an issue where user permissions set in the web app were not honored in the

mobile app.

Processes/ Workflow

Case # Resolution Notes

329390 Optimized two additional queries in the same routine involved with funding data for
mail merge.

329390 Optimized the query to avoid system timeouts.
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333613

336751

338828

339403

339687

339803

340452

340452

341303

342081

342555

342800

If the user has initiated the master process or has been an actor on one of the steps
on the process, they will be able to see it in the list to attach it as a lookup process.
The issue was that even though user was an initiator they were not able to see the
instance to attach it since the user did not have the View permission.

Optimized the code to delete and insert custom fields using temp tables.

If the merge field value had a " symbol and is used in an IF statement of a merge field,
the field values were getting broken out from the " symbol. The code was fixed so
that the value will be displayed correctly, and the IF statement will be evaluated
correctly.

Previously, the "Decline" button would be displayed after accepting the process if the
page was not refreshed. If the popup was closed and opened again, the "Decline"
button would not be displayed when the instance was accepted. This inconsistency
has been resolved and the "Decline" button will not be displayed after the instance is
accepted, regardless of whether the page is refreshed or not.

A confirmation message was also added to check whether the user wants to accept
the change.

Resolved an issue in multiple-pick lists where data with commas would incorrectly get
assigned as multiple values.

Fixed an issue with the default behavior of the Enter key on the Start Process and
instance detail page in IE.

Optimized the query to improve system performance.

Optimized the query using temporary tables.

Upgraded ASPOSE PDF from version 18.5.0.0 to version 19.10.0.0.

When using the "does not contain" or "does not equal" filters, it was not returning
results that had empty or null values. This issue has been resolved so that these filters
return empty/null values.

Importing a process with an Excel template will now auto bind the "Notice to Proceed
Date" to a column in the Import Wizard.

Resolved an issue where all actors were able to decline the process. Corrected the
code to only check whether step actors have declined it or not. If all step actors have
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342876

343495

343561

343633

345294

345459

345634

345732

346269

347096

348225

348901

declined it, then the last actor will not be able to decline. The system will no longer
consider the "requested comment" actor type.

The Invoice Amount column in the Excel sheet for downloaded Schedule of Values will
now match the value in the application. The system was previously calculating this
value based on (unit cost x quantity). Now it is considering an entered amount as an
override.

Resolved an issue where clicking the Custom Field icon would not open the child page
when using Internet Explorer.

When importing a Schedule of Values, if the New Scope items are updated to have
account codes and descriptions, the system will handle it and not throw an exception.

Updated the code so that the mail merge file is generated correctly. Resolved an issue
where the system was incorrectly generating a 0 KB file.

When the overall due date of an instance was read only, a new history was being
created when saving the instance. Now, it will only create a new record when the
date is changed.

Users can now edit the process instance after the finish step. Also, commitment type
validation was added on process instance edits.

The totals in the Dynamic Grid's footer will now be calculated correctly for all values
(regardless of hundreds or thousands).

Upgraded Aspose.Words from version 19.8 to 20.1.

Fixed an issue where downloading an offline workflow document resulted in an
exception error.

An error appeared when adding line items to cost related processes. This issue has
been resolved.

The query to update the cost summary was being done inside a transaction, which
was blocking it and causing the timeout exception. The location of the query was
changed.

Added code to validate duplicate data field entry in the section layout. An error was
thrown if duplicate fields were added, but with validation in place, the system will
now prevent duplicate field entry.
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348909 The query to update the cost summary was being done inside a transaction, which
was blocking it causing a timeout exception. The location of the query was changed.

350564 Improved performance to address an IE - 504 Gateway timeout error that appeared
when submitting a process.

350965 Fixed an issue with mail merge displaying HTML code.

351016 The Mail Merge function now handles double quotes correctly so that the data field
doesn't get truncated after the second double quote.

Projects

Case # Resolution Notes

340915 There was a problem with rendering columns in the MS Edge browser. This issue has
now been resolved and the columns are rendered the same way in all browsers.

351205 Project Detail Page custom field for Company type was not correctly storing the
selected value. This has been corrected.

Reports

Case # Resolution Notes

341834 The alignment for columns in e-Builder Report is now consistent when Print View is
clicked.

344386 When the “Project Most Recent Note”, “Schedule Most Recent Note” or “Task Most
Recent Note” data fields were selected in step 3 of the Report wizard, it caused the
report to fail and no results were generated. This issue has now been resolved.

344992 Bl reports can now export data even when the report is exported from the list of
reports.

345032 A report formula error occurred when creating a formula with a custom field as the

Report Wizard did not consider RoleMember as a valid type for Formula. This has
been fixed.
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346133

346416

347089

347649

347649

349192

349748

350469

351612

The Schedule report was displaying inconsistent results for the Schedule Manager
column. This issue was caused by redundant checking for the schedule manager's
presence in the account group and has now been resolved.

An error was displayed when the Copy User Report page was filtered for a username
that was not in the report results. This has been resolved and the error will not occur

in similar scenarios where there are no report results.

Added history tracking for changes to the Schedule Details page.

Performance has been improved for when running process summary reports.

Performance has been improved for when running process summary reports.

Subscription reports of the Combined Report - Project Cost Schedule type were
failing. The problem was due to the system reading data from the incorrect field from
the database. This issue has been fixed.

When using the search rule '% Complete' equals to '0', the system yielded
inconsistent search results. This issue has been resolved.

Resolved an issue where the use of role member custom fields in a formula did not
yield a value to work with.

The new features in the Audit Log Report required the addition of grouping by
username.

Scheduled Task Engine

Case #

Resolution Notes

350892

Commitments, commitment invoices and general invoices data were not being
imported from SAP. The Aspose Cell upgrade depreciated a method that formats
data.
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Schedules

Case # Resolution Notes

342803 Schedule imports were sometimes timing out when processing very large files. This
issue was related to the database connection and has now been resolved.

344743 When using Internet Explorer, an error appeared while saving a schedule template.
This issue has been resolved.

349271 The My Tasks section on the Home page was incorrectly displaying old tasks that did
not require any action.

349965 An error with the new View Schedule permission removed the Schedule option from
the Project Menu. The option has been restored.

349980 An error occurred when sending schedule tasks to users (internal or external). When
the user clicked on the link in the email, a generic e-Builder error would be displayed.
This issue has now been resolved and the user can click on the links to view the
schedule tasks.

351030 Resolved an error when importing a schedule from an MS Project MPP file.
Submittals

Case # Resolution Notes

351258 Resolved upload and download issues in submittals. Now, the user can successfully

attach a document to submittals using Internet Explorer.

Time Tracking

Case # Resolution Notes

341650 Added the missing AccountlD filter to the query (commitments and invoices).
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Your Opinion Matters

We rely on your feedback to better serve you. If you have ideas about improving our product or service,
please don’t hesitate to let us know. Below are four ways to reach us.

e Like/Dislike m — Located in the banner of e-Builder Enterprise™ are like and dislike
buttons. Click these to express your opinion of a particular page. This feedback is used to help
prioritize upcoming product enhancements.

e e-Builder Product Ideas — The Product Ideas portal gives you a platform to share your thoughts
on how to make e-Builder better. You can read and vote on the ideas of fellow e-Builder users or
post your own. The number of votes is one of the factors considered when forming e-Builder’s
roadmap. To access the Product Ideas portal, click the arrow next to your username within the
banner of e-Builder Enterprise, and then click Product Ideas.

Setup

eB Community
Product Ideas

Help

Logout

e Support — Our Support staff is always available to meet your needs. To speak to a live customer
service representative, call us within the U.S. at 888-288-5717 and outside of the U.S. at 800-
580-9322, or email us at support@e-builder.net.
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